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Getting Started
This document will outline the steps to follow to create ICC profiles using a combination of Wasatch SoftRIP and a 
third party color profiling software package. Further, it will provide instructions for importing the ICC output profile 
into SoftRIP and printing a final test of the newly created Imaging Configuration. The document will also cover 
processes for Hi-Fi profiling.

In addition to this document, you will also need to refer to the ICC profiling software manual for intermediate steps 
where noted. It is recommended that a minimum of 30 linear feet of media be allocated to produce each Imaging 
Configuration.

NOTE: Always adjust the printer before 
profiling. Follow the steps outlined in the 
printer’s user manual for printer adjustment. 
Adjustment refers to the setup processes 
performed on the printer and are specific to 
that printer model. Adjustment processes 
include media feed adjustment, bidirectional 
alignment, head height, media thickness, 
head speed, and any other adjustments 
prescribed by the printer manufacturer. 
These settings should remain constant 
during profiling. All adjustments should be 
redone after loading any new material. The 
printer should be in its optimal operating 
condition before following the steps 
outlined below.

Step 1: Setup Configuration
Launch Wasatch SoftRIP and select Setup from the Print menu.

Select the Printer Model and set the Imaging Configuration 
to none in the Print Setup window (Illustration 1a). Check 
Annotate Prints and the Annotation Details window will open 
(Illustration 1b). We recommend enabling Printer, Imaging 
Configuration, Date/Time, and Comment so each image will be 
printed with the settings and additional comments.

On the Print Setup window, click the Edit button. This will launch 
the Imaging Configuration window (Illustration 1c).

On the Imaging Configuration window, click the Properties 
button. This will launch a window that provides additional 
settings for the printer, such as print modes, resolutions, inksets, 
etc. Every printer has a different set of printer properties. 
Determine the intended output configuration and select from 
features included with the printer. When the selections are 
complete, click OK.

Illustration 1b: Annotation Details window

Illustration 1a: Print Setup window
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NOTE: It is extremely important that all 
printer settings, halftone settings, inks, 
media, print modes, and other factors that 
affect the print condition be set prior to 
ink limiting. If these settings are changed, 
return to the beginning of Step 1 to restart 
the process.

Back on the Imaging Configuration window, 
click the Edit Info button and create a text 
file to record the properties selected as 
part of the configuration. This is especially 
helpful if the final Imaging Configuration 

will be distributed and is a good place to keep track of changes as the Imaging Configuration is built. When Edit Info 
is clicked, the default text editor will open for entering notes. When done, select Save from the File menu and the 
info.txt file will be saved within the Imaging Configuration. This information will be available to anyone who clicks 
the Info button later. This file can be edited at any time.

Step 2: Color Transforms Configuration
Click on the Color Transforms button to launch the Color Transforms window (Illustration 2a). This is the master 
color flowchart window. Notice that all color data is cleared and set to none or default (as a result of setting the 
Imaging Configuration to none). In the lower right hand corner of the window, note that Precision Stochastic Screens 
is displayed as the default halftone method. For most applications, Precision Stochastic Screens is the preferred 
halftone method and Wasatch Imaging Configurations are created using it.

However, it is possible to choose from a 
few halftone methods from this window on 
which to build an Imaging Configuration. 
Whatever halftone method is chosen will be 
incorporated into the Imaging Configuration. 
Changing it later will invalidate the Imaging 
Configuration. This technical document only 
covers processes for profiling with Precision 
Stochastic Screens. Profiling steps will vary 
for other halftone methods.

In the ICC Input Profile column on the 
left side of the Color Transforms window, 
all four input color spaces should be set to 
System Default. Also, the default rendering 
intent of Perceptual has been set. If the 
design workflow includes using embedded 
ICC profiles, check the Use Embedded ICC 
Profiles box.

Click OK to exit the Color Transforms 
window and click OK again to exit the 
Imaging Configuration window. A Save As 
window will open to name the new Imaging 
Configuration. We recommend naming the 

“in-progress” Imaging Configuration with a name like Unlinearized_None. If making Imaging Configurations for 
use in a production capacity, it may be best to avoid having too many ambiguously named Imaging Configurations 
by using a more detailed naming system such as: Unlinearized_None_resolution_inktype_media.

Step 3: Test Print
On the Print Setup window, make any other non-color related selections required for printing. These settings include 
Physical Connection, Paper Width, etc. Click OK. SoftRIP is now ready to print the test prints.

From the File menu, select Open and browse to C:\psfiles and select the appropriate target file for the densitometry 
device, such as generalTest018eyeone.ps or generalTest018dtp20.ps. Open one of these files and select RIP and Print 

Illustration 1c: Imaging Configuration window

Illustration 2a: Color Transforms window
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to print the file. The resulting print will be evaluated in the next section.

NOTE: The exact location of the psfiles folder may vary depending on the drive to which it was assigned when 
SoftRIP was installed.

Step 4: Determine Ink Limiting
After evaluating the print from the steps above, determine if an 
Individual Ink Channel Reduction to one or more of the channels 
is required. An Individual Ink Channel Reduction is intended to 
correct individual ink channel problems.

Ink reduction is performed for each channel, so look at the 
patches for each color individually. Examine each color channel 
contained in the linearization target in the top left of the 
generalTest target (Illustration 4c). If any visible overinking 
artifacts are present, such as undried ink, bleeding, substrate 
warping, etc., an ink reduction should be applied to that specific 
channel.

To make adjustments to the Individual Ink Channel Reduction, 
click on Calibration from the Color Transforms menu 
(Illustration 4a). Use the slider controls to set the ink reductions. 
These controls may be used for any channel individually or for all 
channels together if the Lock box is checked. Steps differ if using 
fixed dot with dilute inks. See note below.

After setting the ink reductions, re-save the Imaging 
Configuration (named Unlinearized_None or similar) and 
add notes on what changes were made by using Edit Info as 
described in Step 1.

Note on Fixed Dot with Dilute Ink Sets: There are two places 
where Individual Ink Channel Reductions can be performed: in 
Calibration or Halftone Properties. One or the other will be used depending on the inkset and the dot mode being 
used. NEVER USE BOTH SETS OF INDIVIDUAL INK CHANNEL REDUCTION CONTROLS AT 
THE SAME TIME.

If printing with dilute inks (light cyan,  
light magenta, light black, gray, light 
gray, etc.) and the printer is in a fixed 
dot mode, check the Fixed Dot Ink 
Reduction control in Halftone Properties 
and perform all Individual Ink Channel 
Reductions in the Halftone Properties 
window (Illustration 4b).

Total Ink Limit: Review the print of the 
generalTest file to determine if a Total 
Ink Limit is needed in addition to the 
Individual Ink Channel Reductions. 
The upper right area of the test print 
consists of three parts. The first part is a 
step pattern from 0% to 400% total ink 
(Illustration 4d). For the Total Ink Limit, 
select the highest percentage square that is dry and does not have print artifacts.

Wasatch noticed improved results when the Total Ink Limit was applied within the profiling software rather than 
within SoftRIP. The Total Ink Limit will be set before generating patches in the profiling software. This could be 
done at this step or at Step 8.

Illustration 4d: Total Ink step pattern

Illustration 4c: Color patches from generalTest

Illustration 4a: Calibration window

Illustration 4b: Halftone Properties window
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The second part is a series of open 
boxes consisting of composite blacks 
(Illustration 4e). Check this area for media 
bleed, over spray, and resolution issues.

The third part is a series of three rows of 
swatches located below the boxes of black 
lines (Illustration 4f). These swatches consist 
of primary inks and one CMY black in the 
upper right corner (circled in red). The 
CMY black may show excessive bleeding or 
artifacts due to the “inks mixing” where the 

first two tests above do not. This is why it’s very important to review this patch. Check this area for individual ink 
channel retention issues.

NOTE: Be aware of the amount of drying time needed before the patches can be handled in this step because this may 
indicate that further ink limiting is required. This is an individual preference and is determined by what drying time 
would be acceptable in a production environment.

If there are issues with any of these test patterns, set a Total Ink Limit or return to the Individual Ink Channel 
Reduction step to apply stronger reductions. If setting a Total Ink Limit in Wasatch, return to the Color Transforms 
window. Above the Halftone Properties on the right side of the Color Transforms windows is the Ink Limit (Total 
Percent) control. Enter the percent for Total Ink Limit, click OK to exit the Color Transforms window, click OK to exit 
the Imaging Configuration window, and save the “unlinearized” Imaging Configuration.

Step 5: Test Print
RIP and print the generalTest018eyeone.ps (C:/psfiles) target to check for any additional Individual Ink Channel 
Reductions or Total Ink Limits that may be required. All squares should have good retention, show no print artifacts, 
and have no bleeding problems. If there are still ink retention issues, depending on the printer model, there are other 
options that can be used for limiting ink. For example, lower the resolution, or change to a dry mode (if available). 
If changes to these settings are required to create a quality Imaging Configuration, restart the profiling process from 
Step 1.

Step 6: Linearize (Calibrate) the Printer
Open the appropriate linearization file that matches the 
spectrophotometer and printing scenario, such as c:\psfiles\DTP41.ps 
or c:\psfiles\DTP32.ps. Find more information on which file to use 
for the spectrophotometer in the Densitometers section of SoftRIP’s 
online help.

NOTE: If the spectrophotometer is the DTP20 or the Eye-One, the test 
file already contains the linearization pattern and does not need to be 
printed again.

RIP and print the selected linearization test pattern.

Return to the Calibration window and click the Calibration Curves 
button to launch the Calibration Curves window (Illustration 6a).

Use the Options menu on this window 
to choose between performing a 
density linearization (default) and a dot 
linearization (Illustration 6b). The choice 
should be driven by the output type and, 
more importantly, by the expectations of the 
ICC profiling software. Test each setting to 
determine which provides the best results 
with the profiling package.

Select the densitometry hardware from 
the Densitometers menu. Device-specific 

Illustration 4f: Primary inks and CMY black swatches

Illustration 4e: Composite Blacks step pattern

Illustration 6a: Calibration Curves window

Illustration 6b: Densitometry Options window
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instructions for reading the linearization patches will be 
displayed. After following the on-screen instructions and reading 
the test patterns/strips, click OK to exit.

The resulting data will be displayed in the Calibration Curves 
window and will look similar to the curves in Illustration 6c. If 
measuring a smooth substrate without any surface texture, the 
appearance of the curves will usually be smooth without any 
abrupt shifts in the direction of the curve. If such discontinuities 
exist, this may indicate the presence of an inaccurate 
measurement. See steps below to help verify the resulting 
linearization curves.

Clicking Original will display the density measurements for 
each patch on the linearization target. By reviewing these values, 
overinking issues that may not be visible to the naked eye on the 
print can be found. For each color, the highest measured density 
should be displayed at the top of the column with each value 
below showing a lower measured density. If a higher measured 
density is displayed below a lower measured density, as shown 
for the Cyan channel in Illustration 6d, this 
indicates that too much ink is being printed for 
that color channel, even if the scanned print had 
no visual overinking artifacts.

As ink increases, the measured density will 
also increase, but only to a certain point. As 
the printed ink amount increases and the 
maximum achievable density measurement is 
approached, the increase in density diminishes 
and eventually drops off completely. Once this 
point is reached, printing more ink will often 
result in the measured density being lower. This 
is the cause of the overinking issue mentioned 
above. 

To address this issue, cancel out of the 
Calibration Curves window without saving 
the linearization curve, perform an Individual 
Ink Channel Reduction to the channel(s) 
with this overinking issue, save the Imaging 
Configuration, RIP and print the test target, and 
re-measure. Repeat these steps as necessary 
until the maximum measured density is 
displayed at the top of the column in Original 
Data for each color, with all values below 
descending.

When complete, click OK until the Save As 
window is displayed. Name the Imaging 
Configuration so that it is identified as the original linearization data.

NOTE: Exit all windows by clicking OK, instead of Cancel, or the data will be lost.

Step 7: Confirm Linearization (Optional)
NOTE: This step is optional and not necessary to create an Imaging Configuration. However, as this step will help 
confirm the accuracy of the linearization curve scanned into SoftRIP in Step 6, and an accurate linearization curve 
is an important part of a quality Imaging Configuration, it is highly recommended to follow the instructions below 
closely to confirm the linearization process was successful.

As this step is only to confirm that the linearization curve is accurate, DO NOT use the OK button when exiting 

Illustration 6c: Calibration Curves display

Illustration 6d: Density measurements for each patch on the linearization target
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from these windows during this step unless explicitly instructed 
to do so. It is very important to use the CANCEL button to exit all 
windows. Clicking OK will write over the linearization data with 
the confirmation data and invalidate the linearization process.

RIP and print the same linearization test pattern from Step 6 using the 
linearized Imaging Configuration. If one of the generalTest files was 
used, RIP and print it again.

Open the Calibration Curves window. Use the Options menu to select 
the same linearization type used in the original linearization. Select 
the hardware from the Densitometers menu again and follow the 
steps to read the linearization patches from this newly printed target.

When asked to overwrite or add the new curves to the linearization, 
choose Yes.

Now the curves shown in the Calibration Curves display should look 
nearly linear (Illustration 7a). If the curves look linear, use the Cancel button to back out of all windows and return to 
the main window.

If the curves do not look linear, have large bumps, or fall sharply away from the center line, perform a new 
linearization. To do this, first clear out the linearization curves by using Clear All from the top menu. Click OK to exit 
out of the Calibration, Color Transforms, and Imaging Configuration windows. Re-save the Imaging Configuration 
with a new name (such as Linearization_Second_Attempt).

Return to Step 6 to perform a new linearization and repeat the steps to confirm linearization. If the curves still 
have bumps or fall away from the center line after the second confirmation, reconsider the Individual Ink Channel 
Reduction settings.

Step 8: Print Profile Target
Open the profiling software being used and generate a standard set of patches. The Total Ink Limit may need to be set 
at this step before generating the patches (refer to Step 4). 

Now, with the newly created linearized Imaging Configuration applied, RIP and print the file created in the profiling 
software. Allow the patches to dry (if necessary) and scan the patches into the profiling software. Save the generated 
ICC or ICM file to a location easily browsed to for importing into SoftRIP, such as the Windows Desktop.

NOTE: When working with a Hi-Fi print 
mode, additional steps may need to be taken 
in the profiling software for best results.  
1) If the profiling software applies a curve to 
Spot Colors, we recommend modifying the 
default curve so that it is linear for each Spot 
Color. 
2) When profiling a 5 color inkset (such as 
CMYKR or CMYKOr) with i1Profiler, ensure 
the software is configured to save the ICC 
or ICM file as a version 2 profile rather than 
a version 4.2 profile (shown as version 4), 
which is the default in i1Profiler.

Step 9: Import Profile
Once the ICC profile has been generated from 
the profiling software, import it into SoftRIP 
and match it to the linearization in the Color 
Transforms window (Illustration 9a).

To do this, open the Color Transform menu. 
In the middle section of this window is 
the ICC Output Profile section. It should 

Illustration 7a: Confirm linearization

Illustration 9a: Color Transforms window
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still show None as the profile. Browse for the correct ICM or ICC file in the directory where it was saved from the 
profiling software. Once the output ICC profile is selected, the arrows on the Color Transforms window should turn 
green, indicating that the color workflow is working correctly with an output ICC profile in place.

Click OK until the Save As window is displayed. Save the Imaging Configuration with the desired final name. 
We recommend using the Resolution_Inkset_Media naming convention to make it easier to find the Imaging 
Configuration later. Clicking OK will save the Imaging Configuration. The Imaging Configuration can now be 
accessed from the Imaging Configuration pull-down menu on the Print Setup window.

Step 10: Print Profile Test
With the new Imaging Configuration complete, we recommend 
printing a reference file to help determine the quality. Wasatch 
does not supply a file for this use, but we suggest creating one 
internally as a final standardized testing procedure. This test file 
should be one in which the original color is standardized. We 
recommend NOT using a customer file or a random color file as it 
will be difficult to locate color issues in these types of files. Rather, 
Wasatch recommends printing a standard, familiar image. It 
should have primary colors, secondary colors, and an image with 
details like faces, shadows, etc. It should also have both CMYK 
and RGB components.

Be sure that all color and printer settings are consistent with the 
settings used when the ICC profile was generated. RIP and print 
the test image.

Analyze the print for quality assurance in order to determine 
whether the new Imaging Configuration should pass or fail. 
Things to check include: posterization, lizarding effects, turtling 
effects, bleeding, banding, patterns introduced by process, and 
any other abnormalities. Also, check the final print for saturation 
and overall color. Keeping in mind that different substrates 
(media) will look different, it is reasonable to ask: “Is this the 
expected behavior for the media and resolution?”

NOTE on Hi-Fi Profiling
Hi-Fi profiling refers to creating Imaging Configurations in SoftRIP using a printer that has an inkset with colors 
beyond CMYK, such as RGB, OrGr, RdBl, etc. For these inksets, please refer to the instructions below for important 
differences in the steps above when creating Imaging Configurations.

As in Step 3, it is important to select the appropriate target file for the densitometry device. For Hi-Fi profiling, due 
to the increased number of colors, it is important to select a target file that will address the total number of colors 
present on the printer being profiled. To do so, determine the total number of non-dilute colors in the printer’s inkset. 
Here are a few examples:

•	CMYKLcLmOrGr and CMYKRdBl use six each
•	CMYKLcLmLkLlkRGB uses seven

If the inkset includes dilute colors, such as Lc, Lm, Lk, Llk, etc., SoftRIP treats these as supplemental to the color 
channel they are a dilute of and should not be included in the total count of color channels. For example, the inkset 
CMYKLcLmLkLlkRGB has eleven different inks but only has seven primary color channels. In this example, the 
target file generalTest018eyeone_7color.ps would be the correct choice.

Once the total number of non-dilute colors has been determined, use the version of the generalTest018eyeone_
Ncolor.ps or generalTest018dtp20_Ncolor.ps where ‘N’ is the number of non-dilute colors in the inkset. Use this 
target for steps 3 through 7 above in the same manner as when creating a CMYK Imaging Configuration. Once Step 7 
is complete, and linearization is confirmed, proceed with the steps below.

After printing the generalTest target for the linearization check that is done during the validation in Step 7, scan the 
linearization target to verify that it is linear and examine the row of composite black patches (running from 25% to 
400%) located in the top right corner for any overinking artifacts.

Illustration 10a: Profile test
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All brand or product names are trademarks or 
registered trademarks of their respective holders.

Use the value of the patch with the most ink that doesn’t bleed to set the Total Ink Limit when generating the first 
target from the ICC profiling software. After the ICC profiling target file has been generated with the Total Ink Limit 
used from the step above, print this file and examine it for any overinking issues. If none exist, proceed to scan this 
target, generate an output ICC profile, and import into SoftRIP as outlined in Step 8.

If the printed ICC profiling target does have overinking issues, go back to the ICC profiling software and generate a 
new target with a larger reduction. If there are only a few places with minor bleeding, it may be best to let the target 
dry for an hour or so, scan, and see if the ICC profile generated from the data creates a quality result.

NOTE on Setting the Total Ink Limit Below 200%
When setting the Total Ink Limit, it is best to set the maximum value without introducing overinking artifacts. For 
many profiles, this value is often in the range of 250% to 350%. In special cases, it may be necessary to set the Total 
Ink Limit below 200%. While this is more common with Hi-Fi profiles, it may be necessary for some CMYK profiles as 
well. This section gives additional tips when setting the Total Ink Limit below 200% for most situations.

When setting the Total Ink Limit below 200%, there is the possibility of artificially restricting the overall color gamut 
of the resulting profile. To maximize the resulting color gamut, try to keep the Individual Ink Channel Reductions set 
to their maximum values without introducing overinking artifacts.

When possible, use the controls available in the ICC profiling software to set the Total Ink Limit.

The first step to setting the Total Ink Limit in the ICC profiling software is generating the ICC profiling target file. Use 
the controls available in this software to generate a target with the appropriate Total Ink Limit as determined in Step 4 
above.

Some ICC profiling packages do not allow an ICC profiling target to be generated with a Total Ink Limit below 200%. 
If an ICC profiling target with a 200% Total Ink Limit prints with some minor bleeding, but an acceptable amount of 
dry time still allows the target to be scanned with a profiling device, it is recommended to proceed. Once the target 
has been scanned, set the Total Ink Limit to an appropriate level below 200% when generating the ICC profile.

If the 200% target print has overinking issues that makes scanning impossible, even after an extended dry time, do the 
following:

•	 Set an appropriate Total Ink Limit in SoftRIP prior to printing the 200% target.
•	 Print and scan the target.
•	When generating the ICC output profile, set the Total Ink Limit LOWER than the value set in SoftRIP.


